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Top GISDK Errors

\

\

2 Wrong types of data

W/

for i = 1 to 10 for

cumnlative = cumalative 4+ 1

end end

2 Array not initialized

2 Wrong number of parameters (comma)

2 Syntax error of the “for” and “if” statement (do, end)

a = 10
if a > 10 then

i=1to 10 then do
cumalative = cumalative + 1
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Top GISDK Errors

2 Change array elements unintentionally

2 Typo (GISDK is case sensitive)
» Typo could be a very dangerous error, and takes a lot of time to debug

2 Logical Error

™
>~ - 4
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Joining Data

» Layers have an associated data table (=)

» Data can be joined (3¢ ) to other tables
» Roadway Network + Traffic Assignment results
» TAZ layer + Land Use Data
» Roadway Network + Lookup Table
» More...

# This is how traffic assignment results are
viewed in TransCAD
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Joining Data

on B8 @ ' =01 1. Select the Primary join table

Szfﬁﬂw »  Be careful: Check the Field
Mame [geo_byr+hwyload_AM @ Ny
Joining from {left side of join) 2. SeleCt the Secondary JOIn
Table geo_byr o~ -
reid LnkD (1 ’ M table
Examples 8650, 8651, 286, 255, 295, 337, 376, 411, 446, 44 »  Be careful: Check the Field
To {right side of join)
Table fofoad A - 3. Create a name for the view,
Feld D1 \;} - or use the default (do this
Examples [2.4,5,6.7. 8,9, T 12. 13 Iast)

| oK || Cancel |

Tip: You can open a file from the join dialog box

To [right zide aof join]
Table |File Open... |

- Ii_
E:-:amples| ﬁ
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Practice 6a: Join the output flow file (.bin) to network links dataview and
label the map

This slide is meant for handout — print and practice using the steps shown.

1. Open the abmioad.dbd file: (oin W - - w2 )
e — i — s —
v' goto File>Open, then in the file type dropdown next to ‘File ?'—|
name:’ select Geographic File(*.cdf,.*dbd) option ngs | Options
v Browse to the location/folder where the geographic file is Create Joined View
located and select the ‘abmload.dbd’ and click ‘Open’ button Name |geo_byr+hwyload_AM
2. Open output flow .bin file oining from {eft side of join)
v" goto File>Open, then in the file type dropdown next to ‘File Table geo_byr /\ M
name:’ select Fixed-format Binary (*.bin) option / Field LINKID 1 -
select the ‘hwyload_AM.bin" and click ‘Open’ button mples | 2650, 8651 286 S0F 295, 337 376, 411, 446, 44
v
* There are multiple ways to open the flow file to join. Will 7| To fright side of join)
be covered in the training Table hwyload_AM /\ -
/ Field 1D \ 2 v
3. Click ‘Join Dataviews’ icon 3& o Examples |3. 456789 T2 13
v" Select ‘LILNKID’ field for Joining from (left side of join) /
v"In the bottom section by default the ID1 will be selected fof the | OK || Cancel |
right side of join — keep it (no need to change this) _—— —
v Give a name if default name is not to your preference ) o o )
v Click OK Tip: You can open bin file from the join dialog box
4 Click map window and label ma 'ft:| e el e el
' P P Table |File Oper.. =]

v" Use one of the flow file output fields to label. For example: _ _
AB_Flow_PCE & BA_Flow_PCE. Field
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Practice 6b: Use ICTM TAZ layer and SED data and practice join and
labeling map with Population and Employment

This slide is meant for handout — print and practice using the steps shown.

Settings | Options
Create Joined View
MName |TA.Z_t'IH'nodel_sed

}E Joining from {left side of join)
Table TAZ t1
HINT > .\
Field ID_TAZ12a 1
-:5:| Examples | 43534000,

To (right side of join)
Table model_sed

P
Field TAZ (?\

Examples | 60001000,
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User Variables

» Creating your own variables

» Additional fields can be added to links & nodes
layers

» Field names can contain spaces and numbers, and
do not have a practical limit to the number of
characters

» HOWEVER...
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User Variables

» Creating your own variables

» Itis preferable to:
= Limit field names to 10 characters
= Avoid using spaces
= Avoid starting a field name with a number

» If these guidelines are followed, compatibility with

other GIS programs will be improved

= Field names that do not follow these guidelines will have
truncated or confusing names when exported to a
shapefile
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Centroids

» Centroids are special nodes that are linked to
socioeconomic data

» If data i1s added for new zones, new centroids and
centroid connectors must be created

» New nodes are created by adding
a link that has one end that is not
located on an existing node

» TAZ numbers are entered in the |
Z/ONE field g ZmemmT

» The network update macros
update the “ID” field to match
the TAZ number
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Roadway Network Editing




Network Editing

» Warning: Make a backup copy first!
» There Is an “Undo” function in TransCAD

» Edits are made directly
to the network file: You
can’t close without saving
to discard changes

» Network files sometimes become corrupt
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12

Network Editing

» Backing up the Roadway Network
# Method 1.

12

» Close all files in TransCAD

» Create a zip file with the line layer
and route system files

» Make sure to get all related files

Method 2:
» Open the network in TransCAD

w Toolbox

v Selection
Map Editing
Imagery
Surface Analysis

Lacate
Geoqgraphic Analysis

zengraphic Lkilities

Export. ..
Qpen in ArcMap...

Slide Show, .

add-Ins. ..

Read GPS Data...
Lines of Sight. ..
Rubbersheet. ..
Create Wector Grid. ..

Line/Area Conversion, ..
Clip by Area...

Merge Geography. ..

» Use Tools = Geographic Utilities = Geographic
File to access the Geographic File dialog box
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Network Editing

» Method 2 (Continued):

» Backing up the Roadway Network
» Click the “Copy...” button to save a copy of the

13

network file

» Choose a location
to save the backup

» You are still working
In the original file.

» Or, use Archive to
save In a zip file

Geographic File

=S8 - hopoints, Base Metworl,

Fath | PALAPLATACOUNTY_LAISI0AMODELMODEL

Label |Base Metwork

File Mames [|apla

el el erall -l el vl

oy == Wy = Ry =Ry = By = Ny = = iy =

[T TR TR <A T LA TR T T
[T T

anetwork. des; laplatanetwork.grp;
network. cdd; laplatanetwork. i0;
network.rl ; laplatanetwork. dsk;
network. cdk; laplatanetwork, prlk; Restare...
network. lok: laplatanetwork. dbd;
network. pte; laplatanetwaork_ sty; [ ptimize
network. sty laplatanetwork, fs;
network_ bin; laplatanetwork,_ dcb;
atanetwork_.be; laplatanetwork. bin; Metadata
anetwork.deb; laplatanetwark, by

Total Size | 7185 KB
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Network Editing

# Once you have made a backup, you can:
» Edit attributes of existing links

» Change data for a specific year or for multiple
years and alternatives

» Add new links, delete existing links, or realign
existing links

» Add data for a year not yet included in the network
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Network Editing

» Edit attributes of existing links
» Display settings can assist with editing

« Additional labels and/or
themes can be useful

» Label # of lanes or other
values

» Show Topology ( & )
to see AB vs. BA
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Network Topology

» Show topology to identify AB and BA
directions

’.ﬁ

/ \ —;r>_ E
—

> P

B)—e—
AB = East to West
BA = West to East

| AB = West to East
BA = East to West

» To identify one-way roads, use the DIR field:

» 0: Two-way travel
» 1. A-> B travel
» -1. B 2 Atravel
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Network Editing

» Edit attributes of existing links — Method 1

» To make most edits, use the information tool ( @ )
and edit text in the form that appears

» Changes can be undone B e
= Each edit action creates an undo point [l = e e
» You can select and fill multiple o
links with the information tool i TR
= Multiple values can be filled by woad
right-clicking on row names e ——

-\._._.-" B I
—L‘i ISR IE N O U O S SR S SR S i}:
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Network Editing
Alternate Method (Method 2)

» Edit attributes of existing links ——
Alternate Method SN RIEIE

18

» Use the map editing toolbox ( &)

» Use the Edit Line Attributes (|/]) button

= QOperation of this tool is similar to using the information
button

» Edits are saved when the green light ( E)) is
clicked

» Use the red ( #|) light to cancel all unsaved edits

» The Undo function will undo all edits that are saved
at once with the green light
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Network Editing

2 What Fields do | Edit???

» Facility Type
= 2 or 3-digit facility type identifier

» Lanes
= Directional number of lanes
= Aux. lanes

» Direction
» Other fields as necessary

19
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Practice 7. Network Editing — editing attributes

There are multiple ways to edit network link attributes

v
v
v

20

Example of Method 1:
Open geographic file (.dbd)

Zoom to focus area where a roadway is planned for
improvements

Select multiple links using identifier icon in the toolbox ] Dataviewl - geo_byr Info
Right click on the IFC field and use fill option and change the - '[}: 3?0533| 370522| 9033;} 9D319§| :
IFC code from 4 to 3 - engt ' ' ' '
Drir 1] 1] 1] 1]
Example and details of Method 2 will be covered during - |} [Length:1]] 376302190 1136536600 426063840 62548280 1106.0%
the hands-on session and notes will be provided. M FURY FURY FURY FURY F
IFC| 4 ] 4 4
IHOY| - ” ? ? ? .
Tafa] | Fill ) =
ABLNL | pil Method
ABAL
BALM @ Single Value [3
L:BI'JAKL\;E (01 Sequence Start (1 Step (|1 :
() Formula |
@ Tag  Using laver
e P oy, I Tag with
Voo
: '&l () Aggregate
. [
"'\\1 | ) Clear all values in the range
| (__' -.\'{’_/ u"‘:.
| _—— [ ok | [ Canel |
=} |
\ . R | . T T — T o
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Network Editing

« Adding new links
» Use the map editing toolbox ( &)
» Add links using Add Line ( (%))

= To work properly, links must be connected at nodes
= EXxisting links may need to be split
= Avoid splitting links if possible
» Make sure that links are connected by:
= Saving edits
= Moving a node around — do all of the attached links move
with it?
= Canceling the edit
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Network Editing

» Adding New Links

» New links need new data!

» Copy data from an existing link with similar
characteristics
= Use the Edit Link Attributes (|_|) button
= Click/shift-click on the new link(s)
= Shift-click on the similar old link

= Right-click on the data for the “old” link and choose “Copy
Values”

h » Spllttlng/Jomlng Links e wa
Check the split/join settings [ Curves i%la LK
= Use the split/join tools (|»«|«s|)
= New/moved links may be connected at new nodes
= Check data on split/joined links doin/Spit Nirbte Setings 1 —
( Update... A ]
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Network Editing

.--"'“‘-\
" 29
5188
Mf?@s

S

e Map Editing (=]

- I Gl GGl m| el e
o~ [¥] Curves % 8 i i
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Practice 8:
Network Editing

Key network editing options will be covered during

Map Editing (5] '
the hands-on session.
{E|{:|(§|:i—:|f; /ol v" Editing attributes
] Cus
rves &% 5 i i v/ Copying attributes from one link to other link(s)

v Editing geometrics
Adding links

v/ add a centroid connector or a new roadway connection

<

Splitting links
Joining links
Deleting links
Replacing links

D N N N N

Configuration settings

Please note: Notes for a few of the options are provided in the following slides; the
details will be better to discuss during the hands-on session. Practice slides notes
will be improved after hands-on session.

CAMBRIDGE SYSTEMATICS i
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Adding a new link

v VvV vV

¥

25

the network but it will not have

Click ‘Add line’ —~ e

One left click at node 1 9526

Double click at node 2

Map Editing (=]
Click green light to save 63 &lEl G| %
changes /] Curves v Alslk k. @

Now the link will be added to \

any attributes (attribute data).
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Copy link attributes

» Copy link

B

Dataviewl - geo_byr - Editing a...|. = | = = |

attributes from
existing link to
new link

» Existing link

@
&)

26

Map Editing (=]

GlElElEleldm el |

[¥] Curves -4 il ‘l
L

Ca—
k. 4

Are you sure you want to fill 1 records with values from the selected
record?
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Practice: Network Editing

» Try adding a new centroid connector

» Copy centroid connector values from an existing
connector
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Network Editing

# Things to keep In mind:

» When splitting links, make sure the data on both
pieces still makes sense

» When adding new roadways, adjust centroid
connectors If necessary
= Centroid connectors can be specific to a year

» Keep the data for all years up to date
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TransCAD Matrices

H TransCAD (Licensed to Cambridge Systematics)

Eile Edit Matrix Tools Procedures MNetworks/Paths Route Systems Planning Tranwguting_fLDgistics Statistics  Window Help

063 (1 Qg Ev_Auo DA + No marginals -EOHRESE|IGrAE DS e A~ E e ¥ X B PR
5 A \
Matrixd - AMSelect Trips (Ev_Auto [DA]) (= [=][=]

1| 2| 3 4 5| 6| 7| 8| 9| 10| 11| 12 .
1 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 |
2 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
3 0.00 0.00 0.00 0.00 0.00 0.qn Jan 0.00 0, n oo, 0.00 0.00
i v N

4 0.00 0.00 0.00 0.00 0.00 0.0 4o File Contents .o |_, 57 _| 1.00 0.00
5 0.00 0.00 0.00 0.00 0.00 0. - — — ~— 1.00 0.00
6 0.00 0.00 0.00 0.00 0.00 0. T 1.00 0.00
7 0.00 0.00 0.00 0.00 0.00 00 | [AMSslect Trips 1.00 0.00
8 0.00 0.00 0.00 0.00 0.00 0. Fie Info_ 1.00 0.00
9 0.00 0.00 0.00 0.00 0.00 0. Matrix Name(s) 1.00 0.00
10 0.00 0.00 0.00 0.00 0.00 NI NIE, At [DA] L : 1.00 0.00
11 0.00 0.00 0.00 0.00 0.00 o.d | |Ev_Auto [SR2 HOV] Add Matrix 100 0.00
12 0.00 0.00 0.00 0.00 0.00 od| = E A - Drop Mairx 1.00 0.00
13 0.00 0.00 0.00 0.00 0.00 od | e -an [5R3 NONHOV] .00 0.00
14 nnn n nn nnn n nn nnn n Ev_Auto [LIGHT TRUCKS] 100 nnn~
* sl Ev_Auto [MEDIUM TRUCKS] :

Ev_Auto [Port Baobtail]

Ev_Auto [Port Chassis]

Ev_Auto [Port Cortainer]

Ev_Auto [Port Transload]
Ev_Auto [Port NonContainer]
Ev_Auto [Port Autos]

Ev_Auto [HEAVY TRUCKS]
Ev_Auto [Intermodal Domestic]
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Practice 9. Matrix Operations

Introductory matrix operations will be
covered during hands-on session.
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Flowchart of the Caltrans D11 Highway Post Processor

Base Year
Network
(.dbd)
Corridor Links Flow Direction
Identification Identification

Corridor Definition
(.bin)
I

Count Station
File
(.dbd)

Tag Stations with Link
Attributes

Base Year T

Assignment
(Well)]
Calculate Calculate

Peak Hour Factor Adjustment Ratio
Base Year Count

(.xIsx)

Lookup Table

FutureYear
Network

(.DBD)
Corridor Links Ramp Type Flow

Identification Identification Direction

Match Links to Count
Stations

Future Year
Assignment
(.bin)

Peak Hour Volume

Adjusted Peak Hour
Volume

Loaded Shapefile
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